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1. Introduction

1.1 Scope

This document analyzes the features and usage of MySpec version 1.0. In
addition, there is a brief description of the theory, together with examples that cover

all different options.

1.2 Program requirements

The minimum requirements are:
> Operating System: Microsoft® Windows 95/98/ME/NT/2000/XP

» Visual Basic 6 Service Pack 5 runtime libraries.

1.3 Abbreviations

SDF: Single Degree of Freedom
2DOF: Two Degree of Freedom

ODE: Ordinary Differential Equation

1.4 About MySpec

This program calculates the response of a SDF or a 2DOF system which is
subjected to an excitation. The analysis may be linear elastic or non-linear. The

response is calculated for several models.

The typical excitation corresponds to a ground motion specified by an
earthquake. However, an arbitrary excitation force can be used as well, either alone or

together with an earthquake.

All diagrams of interest can be plotted on the screen or sent to the printer. Also,
the results can be exported in the form of ASCII text files. Moreover, such files can be

easily inserted to a spreadsheet application.



Apart from the diagrams, the program is capable of producing a simulation of the
behaviour of the system in animated form and idealised as a lumped mass on the top

of a column of specified stiffness.

All calculations are carried out using double precision arithmetics.



2. Interface

2.1 Main window

The main window of the program appears as follows:

* MySpec 1.0.50 (=13

File Wiew Earthquakes Excitations Linear Elastic Analysis Mon-Linear Analysis (Bilinear) Bouc-Wen Analysis  Options

# AP X ¥

Ly o

There is a standard menu, the toolbar, the main drawing area and the status bar.

2.2 Toolbar

The toolbar contains the following buttons:



* MySpec 1.0.50 (=13

File Wiew Earthquakes Excitations Linear Elastic Analysis Mon-Linear Analysis (Bilinear) Bouc-Wen Analysis  Options

Q‘QQ%Q? Y

pan

zoom window

Zoom in

zoom out

zoom all

Z0O0Im previous

about

2.3 Drawing tools

Only one drawing can be shown at a time on the screen. The drawing tools can
be found under the "File”and "View”menus. The most useful menus can be accessed

directly from the associated buttons in the toolbar.

2.3.1 Print drawing

The current drawing can be printed directly to the printe, by selecting "Print
Drawing”from the "File” menu.
If you haven't already selected a printer, a form displaying all printers will

appear. You must select a printer in order to proceed. You can access the printer

selection form later by selecting "Configure Printer”under the "7ools”menu:



Printer configuration El

Aveailable printers Configuration

5 tec Fax Starter Editi

Fan ; (" Landscape " Mono
Auto HF Laser)et 2200 Senies PCL B or
YWWERAFEIOTAHP 11200

“MtzerversHP Laserlet 2200 Seies PC . .
Available paper sizes

o - | Letter j

Copies |1 =

Configure |

Ok | Cancel |

2.3.2 Save image as .bmp file

You can save the current drawing as a bitmap, by selecting "Save image as

.bmp”from the "File”menu. This file can be modified by all image editing programs.

2.3.3 Zoom all

You can “zoom all” i.e. display the entire drawing by selecting "Zoom A//” from

the "View”menu, or by clicking the associated button in the toolbar (see 2.2).

2.3.4 Zoom window

You can “zoom window” i.e. zoom to a part of the drawing by selecting "Zoom
Window” from the "View” menu, or by clicking the associated button in the toolbar
(see 2.2). You need to click twice on the drawing to specify the diagonal of the

window.

2.3.5 Zoom previous

You can “zoom previous” i.e. return to the previous zoom by selecting "Zoom
Previous” from the "View” menu, or by clicking the associated button in the toolbar
(see 2.2).

2.3.6 Zoom in

You can “zoom in” i.e. zoom to a specified point by selecting "Zoom In”from the
"View” menu, or by clicking the associated button of the toolbar (see 2.2). You need to

click on the drawing to specify the point of zoom.



2.3.7 Zoom out

You can “zoom out” by selecting "Zoom Out” from the "View” menu, or by
clicking the associated button of the toolbar (see 2.2). You need to click on the

drawing to specify the point of zoom.

2.3.8 Pan

You can “Par’" i.e. move the drawing using the mouse, by selecting "Pan”from
the "View” menu, or by clicking the associated button of the toolbar (see 2.2). You
need to click and drag on the drawing in order to specify the move.

2.4 Status bar

The status bar displays information about both the active command and the

current mouse position:
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Specify window ko zoom TIME =£.175 sec, GROUND ACCELERATION =-0.005 units of g

2.5 About box

You can access the about box by clicking the associated button of the toolbar
(see 2.2):
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About MySpec 1.0.50
ﬁ MySpec 1.0.50

Copyright [£] 2002 - 2003, NTUA Athens, Greece
Department Of Civil Engineering
Institute of Structural Analysiz and Aszeismic Research

Profeszor V. K. Koumousiz

Aristotelis Charalampakis
Chiig Catgaras
Pancs Dimizas

Cantact: vkour(@zentral ntua.gr
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3. Earthquakes

3.1 General issues

All earthquake data is stored in an “earthquake library”. When a certain model is
used, the user can select the earthquake by selecting its name from a standard

windows dropdown list box.

The earthquakes can be modified (“amplified” or “stretched”) with respect to the

original data. Also, a certain subset of the original data may be used.

Most functions related to earthquakes can be found under the "Earthquakes”

menu.

In order to load an earthquake, you need to use a file with a certain format,

described later in this chapter.

3.2 File Format

The file is a standard ASCII text file. You must use a dot “.” as the decimal

symbol.
The file format used is the following:
> Default extension: .EQK (this is not compulsory)
> First line: Earthquake title (string)

> Second line: Units. It can be “g” for units of g, “g/10” for tenths of g,
“m/sec”2”, Vin/secN2” etc.

> Third line: Time step in seconds, for example 0.02

> Forth line: First entry, ground acceleration for t = one time step. For t =

0, the acceleration is set to zero by default.
> Next lines: The rest entries. The last entry should be zero.

For example, the file might look like this:

North South ground acceleration, El Centro, May 18th, 1940.
G
0.02

0.0063

12



.00364
.00099
.00428

.01087

0

0

0
0.00758
0
0.00682
0

.00277
-0.00128
0.00368
0.00864
0.0136

0.00032
-0.00025
-0.00019
-0.00013

-0.00006

3.3 Earthquake library

To access the earthquake library, select "Earthquake library” under the

"Earthquakes”menu. The following form will appear:

Earthquake library

Mew

Selected Earthquake:

UmEd

Cloze

3.3.1 Add new earthquake

In order to add a new earthquake, click on the "NMew”button of the form of the

earthquake library. The following form will appear:

13



Earthquake Data

File Infarmation-
Filename |
Title | Laad Fils
Dezcription |
File: Farmnat & MySpec
Original Froperties Original Peaks
Mumber of entries: Acceleration unitz of g
Time Step [zec] Welocity mizec
Diuration [sec) Displacement m
Ao datain
fodified Properties Modified Peak s
Amplification Acceleration urits of g
TimeScale Welocity migec
Mumber OF entries: Displacement m
Time Step [zec]
Duration [sec)

Cancel |

Click on the "Load File” button on the top right corner and select a valid file.
(Refer to 3.2 File Format for further information). After having loaded the El Centro
earthquake, the form may look like this:

Earthquake Data

File: Information-
Filenarme |E:\MY STUFFYPhDMS ource CodehMySpechEl Centro.eqgk
Title |EI Centro.egk Ll
Description |N0rth South ground acceleration, EI Centro, May 18th, 19401
File: Farmat ' MySpec
Orniginal Properties Original Peaks
Mumber of entries: ,15597 Acceleration ’W unitz of g
Time Step [zec] ,wi Welocity ,W mizec
Diuration [zec) ,31137 Dizplacement ’W m
Ace datain l—_l
Modified Properties Modified Peak s
Amplification ,17 Acceleration W unitz of g
TimeScale ’17 Welocity ,ﬁ?ﬁl— mizec
Mumber OF entries: ,ﬁﬂ— Dizplacement IET mm
Time Step [sec) ooz
Duration [sec) 3118

(]9 | Cancel |

In the "File Information”frame, the following data is displayed:

> Filename: The full path of the file.

14




>

Title: The title of the earthquake, which will appear on the drawing. The
filename is used as a default value.

Description: The earthquake description found in the file. (Refer to 3.2
File Format for further information). This information is printed in the

reports.

File Format: For the time being, only “"MySpec” format is available.

In the "Original Properties” frame, which is read-only, the following data is

displayed:
>
>
>

>

Number of entries: Number of entries for the ground acceleration.
Time step: The time step in seconds.
Duration: The duration of the earthquake in seconds.

Acc data in: The units of the ground acceleration data.

Based on this information, the program calculates automatically the acceleration,

velocity, displacement peaks, which are displayed in "Original Peaks” frame. The units

in which the results are displayed can be changed by selecting "Units” under the

"Options”menu of the main form.

For more information on how the velocity and displacement data is calculated

refer to 3.4 Earthquake calculations.

In the "Modified Properties”frame, the following data is displayed:

>

Amplification: The amplification factor, which can be set by the user. The

default value is 1.

Timescale: The time stretching factor, which can be set by the user. The
default value is 1. A different value will consequently change the time step

and the duration. Do not change this if you don’t have a specific reason.

Number of entries: The subset of entries for the ground acceleration. Can
be smaller than or equal to the counter of the original properties. The
default value is that of the original properties. A different value will

consequently change the timescale factor, the time step and the duration.

Time step: The time step in seconds. The default value is that of the
original properties. A different value will consequently change the
timescale factor and the duration.

15



> Duration: The duration of the earthquake in seconds. The default value is
that of the original properties. A different value will consequently change

the timescale factor and the time step.

Based on this information, the program calculates automatically the modified
acceleration, velocity, displacement peaks, which are displayed in "Modified Peaks”
frame. The units in which the results are displayed can be changed by selecting "Units”

under the "Options”menu of the main form.

Note that all further calculations are carried out using the modified earthquake

data. The original data is kept only for reference.
3.3.2 Delete earthquake

In order to delete an earthquake, select it from the list of the earthquake library
form, then click on the "Delete” button. You must confirm the deletion, as this is

permanent.
3.3.3 Modify earthquake

In order to modify an earthquake, select it from the list of the earthquake library
form, then click on the "Modify” button. Trying to modify for example the El Centro

earthquake, the following form will appear:

Earthquake Data

File Infarmation
Filerame |C:'\MY STUFFYPhDAS ource CodeMySpechEl Centro.egk
Title |[El Centro.eqh UodFie
Dezcription |N0rth South ground acceleration, El Centra, M ay 18th, 1540
File Formnat & MySpec
Original Properties Original Peaks
Counter [M] ’15597 Acceleration ’W unitz of g
Time Step [sec] ,0027 Welocity ’W mésec
Diwration [sec) ’31137 Dizplacement ’W ]
Acc datain l—_|
Modified Properties Modified Peaks
Amplification ,17 Acceleration ’W unitz of g
TimeScale ’17 Welocity ,W mésec
Counter [M] ’15597 Dizplacement ’W mm
Time Step [sec) o0z
Duration [sec] .18

(]9 | Cancel

16



You can now modify the various factors available. Refer to 3.3.1 Add new

earthquake for further information.

3.3.4 Select active earthquake

In order to display the results of the calculations, you must first select the active
(selected) earthquake. You can accomplish this by clicking on "Select Earthquake”

under the "Earthquake”menu of the main form. The following form will appear:

Select earthquake

Selected earthquake:

El Centro.egk j

Cancel |

You can select the active earthquake from the dropdown list box. The list is

loaded with all earthquakes defined in the earthquake library:

Earthquake library
B

Selected Eathquake

[ETCentio ek
Close

Alternatively, you can select the earthquake from the above list and hit the
"Select” button on the right. The active (selected) earthquake is displayed at the

bottom.

3.4 Earthquake calculations

All calculations are carried out using double precision arithmetic.

The ground velocity and displacement are calculated by assuming a linear

variation of the ground acceleration within the time step.

17



At

Also:

Therefore, the ground velocity at all time steps is calculated as follows:

=V +—(A"“ +A")'At

i+l i 2

The ground displacement is calculated as follows:

AP ACAP
DI.+1:D,,+V,,-At+ILL“6 +A’3

Where:

At is the time step

A, is the ground acceleration at time ¢ =i-At
V. is the ground velocity at time 7 =i-At

D, is the ground displacement at time 7 =i- At

3.5 Results

In order to display the results of the earthquake calculations, you must first select
the active earthquake. (Refer to 3.3.4 Select active earthquake for further information)

18



Having selected the active earthquake, you can display the results from the
calculations. All graphs are available, both for the original earthquake and its modified
form.

The units in which the results are displayed can be changed by selecting "Units”
under the "Options”menu of the main form.

The results are displayed by selecting the appropriate graph from the
"Earthquakes > Plot” menu.

Below there is a sample of the results for the El Centro earthquake.

> Original ground acceleration in units of g:

El Centro.eqk

0298

N

nits

Criginal Ground Acceleration, u

N

0319

Time, sec

> Original ground velocity in m/sec:

19



El Centro.eqk

0291

Criginal Ground Velocity, mjsec
| | | | | | | | | | | | | | | | | | |

-0.361

il a0 0

Time, sec

> Original ground displacement in m:
El Centro.eqk

0033

Criginal Ground Displacement, m

0.212

=]

20 30 a0
Time, sec

The modified earthquake results depend on various factors, such as the

amplification and timescale factors.

3.6 Printing and exporting the results

3.6.1 Print results

You can print the results of the calculations directly, by selecting "Print Analysis
Report”under the "Earthqguake”menu. A full report will be prepared, and a stand alone

print preview program will appear:

20



N Earthquake data: El Centro.egk.

% » = QOO0 >l M= 0w 3

ySpec 1.0.49 by Aristotelis E. Charalampakis (aristotelis_charalampakis@hotmail.com)

General Data

Title: El Centro.eqk

Filename: C:\MY STUFF\PhD\Source Code\MySpec\El Centro.eqk
Original Acceleration Data: N = 1559

Original Acceleration Data in : units of g

Modified Acceleration Data: N = 1559

Amplification = 1

Timescale = 1

Unit System

Acceleration : units of g
elocity : m/sec

Displacement : m

Time : seconds

Criginal Data

Original Acceleration Data: N = 1559
Maximum acceleration : 0.298 units of g
Maximum acceleration occurs at: 2.22 seconds

Page 1 of 53, Zoom: 150%

Most functions of this program are self-explanatory.

3.6.2 Export results

You can export the results in a simple ASCII text file, and use it in a spreadsheet
application, for example. In order to create this file, select "Export Results” from the

"Earthquake”menu of the main form.

The results are fixed - aligned in columns with a header for each column. You
may need to modify the file, because both the original and the modified results are
included in the same file.

21



B El Centro.txt - Notepad =)
Fie Edt Fomst vew e

] FUUMBER ORIGINAL TIME INSTANT (s&c) ORIGINAL ACCELERATION (units of g) ORIGINAL VELOCITY (m/s A|

0 0 o

1 0,02 0,0063 6,1803002 64258526
z 0,04 0, 00364 1,59314406814 5758
3 0, 00099 2)04734708757401E
4 0,08 0, 00428 2,56433410068781E
5 1 0, 00758 37278001 5945435E
6 0,12 0, 01087 5, 53774523687363E
7 0,14 0, 00682 7,27313431110382E
8 016 ) 00277 871391335134 508E
9 0,18 -0, 00128 8, 26008235750735E
10 0,2 00368 8, 5955223 67668158
1 0,22 0, 00864 ©)30411441036493E
12 )24 1,10858585126877€
13 0,26 0, 00727 1,40332056002617€
14 0,28 0, 00034 1,48286066347122E
15 0,3 40,0042 1,53428406552805E
15 0,32 0, 00221 1)557166168317708
17 034 0, 00021 1,62000636933327E
18 036 0, 00444 1,666522871284408
19 0,38 0, 00867 1,79513197678566E
20 0,4 40,0125 2} 00673368583679E
21 0,42 01713 2)30132799843788E
22 0,44 0, 00243 2,43572500418663E
23 0,46 - 2,16663669267654E
22 0,48 -0, 00252 1,8338814 78443156
25 0,5 0,00416 1,77737587602615E
26 0,52 0, 00528 1,86008227998734E
27 054 0, 01653 2, 0820383801301 8E
28 0,56 0, 02779 2, 5187176077365%E
20 0,58 0, 03904 17431003577957E
30 0,6 0, 02449 79754926243762E
Y 0,62 0, 00995 4,13540567688042E
32 064 0, 00961 4,32728528509712E
33 0,66 0] 00926 4751240350301 5268
34 068 0, 00802 4165074 980064392E
35 0,7 -0, 00485 4,73057840234757E
36 0,72 -0, 01864 4,50004339248657E
37 0,74 0] 03242 3)50914477106084E
38 )76 -0 03365 3)35000804333687E
30 0,78 0, 05723 0, 024554852052
a0 0,3 04524 1,45225246716202E
41 0,82 -0, 03348 &,80225429096222E
42 084 -0, 03201 7964 7 S17E
43 0,86 -0, 03055 0, 005758470246
41 0,88 -0, 02911 -1,16120074067002E
45 0,9 -0, 02765 1,71812347349167E
45 0,52 -0, 04115 39324 7702369608
a7 0,54 -0, 05465 4104257736E
48 0,96 -0, 06815 538106104114 686
49 0,98 -0, 08165 00784 04 56981668
s0 -0, 06845 480517710974 526
51 1,02 0, 05527 -8, 694 300071803608
52 104 0, 04208 -5,640312612743388
53 1,06 -0,04258 ~0,104790252482
54 1,08 0, 04311 -0,113206423842
55 1 -0, 02428 -0, 110817383125
56 1,12 0, 00545 ~0,122733896249
57 1,14 0, 01338 ~0,121055063216
58 1,18 0, 03221 ~0,117483 384025
59 118 05104 —~0,100316758675
60 13 0, 06987 -9,74554871685082&
61 1,22 0,0 -0, 0! 760503
62 1,24 0, 04524 -6,87602549411774E
63 126 0] 00179 -6,41466117438317E
64 1,28 -0, 04167 80588350111 7488
&s i3 -0, 08513 -8, 04570204432488¢
66 1,32 112858 0,101 40
67 1,34 -0,17204 -0,130953695601
&8 136 ~0)12%08 ~0)160493568865 v

>

The units can be changed by selecting "Units” under the "Options” menu of the

main form.
3.6.3 Print drawing

You can print directly the current drawing by selecting "Print Drawing” from the
"File” menu, as described in 2.3.1 Print drawing. The drawing is printed with the

default printer settings, using the maximum available area.

3.6.4 Save drawing

You may save the current drawing in *.bmp format by selecting "Save Image As

Bmp”from the "File”menu, as described in 2.3.2 Save Image as .bmp.
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4. Excitations

4.1 General issues

MySpec program is capable of using direct excitation data i.e. force instead of
ground acceleration. All excitation data is stored in an “excitation library”. When a
certain model is used, the user can select the excitation by selecting its name from a

standard windows dropdown list.

The excitations can be “amplified” or “stretched” with respect to the original data.

Also, a certain subset of the original data may be used.
Most functions related to excitations can be found under the "Excitations” menu.

In order to load an excitation, you need to use a file with a certain format,

described later in this chapter.

4.2 File Format

The file is standard ASCII text. You must use a period “.” as the decimal symbol.
The file format used is the following:

> Default extension: .EXC (this is not compulsory)

> First line: Excitation title (string)

> Second line: Units. It can be “N” for Newtons, “KN”, “Kips" etc.

> Third line: Time step in seconds, for example 0.1

> Fourth line: First entry, force for t = one time step. For t = 0, the force is

zero by default.
> Next lines: The rest entries. The last entry should be zero.

For example, the file might look like this:

Half cycle sine pulse force
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10

4.3 Excitation library

To access the excitation library, select “"Excitation library” under the "Excitations”

menu. The following form will appear:

Excitation library

=0

Selected Excitation:

Cloze

dAad

4.3.1 Add new excitation

In order to add a new excitation, click on the "Mew”button of the form of the

excitation library. The following form will appear:

Excitation data

File Infarmation-
Filename | :
Title | | LoadFie
Dezcription |
File: Farmnat & MySpec
Orniginal Properties Original Peaks
MNumber of entries: Force M
Time Step [zec]
Diuration [zec)
Force data in:
Modified Properties Modified Peak s
Amplification Force M
TimeScale
MNumber of entries:
Time Step [zec]
Diuration [gec)
(]9 Cancel
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Click on the "Load File” button on the top right corner and select a valid file.

(Refer to 4.2 File Format for further information). After having loaded a valid file, the

form may look like this:

In the

>

Excitation data

File Information

Filerame |C:'\M‘C E;J'UFF\F'hD\S ource Code’MySpechExample 5.1,

Title |EHampIe 5.1, page 170.exc UodFie
Dezcription |Half cycle sine pulse force

File Formnat & MySpec

Original Properties Original Peaks

Murnber of entries: ’57 Force ’107 N
Time Step [sec] ,017

Diwration [sec) lﬂsi

Force data in: l—_|
Modified Properties Modified Peaks

Amplification ,17 Force ’107 M

TimeScale ’17
Murnber of entries: lﬁi
Time Step [sec] ’D‘Ii
Duration [sec] ’%7

Cancel |

"File Information”frame, the following data is displayed:
Filename: The full path of the file.

Title: The title of the excitation, which will appear on the drawing. The

filename is used as a default value.

Description: The excitation description found in the file. (Refer to 4.2 File

Format for further information). This information is printed in the reports.

File Format: For the time being, only “"MySpec” format is available.

In the "Original Properties” frame, which is read-only, the following data is

displayed:
>
>
>

>

Number of entries: The number of entries.
Time step: The time step in seconds.
Duration: The duration of the excitation in seconds.

Force data in: The units of the force data.

Based on this information, the program calculates automatically the force peak,

which is displayed in "Original Peaks” frame. The units in which the results are
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displayed can be changed by selecting "Units” under the "Options” menu of the main
form.

In the "Modified Properties”frame, the following data is displayed:

> Amplification: The amplification factor, which can be set by the user. The

default value is 1.

> Timescale: The time stretching factor, which can be set by the user. The
default value is 1. A different value will consequently change the time step

and the duration.

» Number of entries: The subset of entries for the force. Can be smaller
than or equal to the counter of the original properties. The default value is
that of the original properties. A different value will consequently change
the timescale factor, the time step and the duration.

> Time step: The time step in seconds. The default value is that of the
original properties. A different value will consequently change the

timescale factor and the duration.

> Duration: The duration of the excitation in seconds. The default value is
that of the original properties. A different value will consequently change

the timescale factor and the time step.

Based on this information, the program calculates automatically the modified
force peak, which is displayed in "Modified Peaks”frame. The units in which the results
are displayed can be changed by selecting "Units” under the "Options” menu of the

main form.

Note that all further calculations are carried out using the modified excitation

data. The original data is kept only for reference.

4.3.2 Delete excitation

In order to delete an excitation, select it from the list of the excitation library
form, then click on the "Delete” button. You must confirm the deletion, as this is

permanent.
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4.3.3 Modify excitation

In order to modify an excitation, select it from the list of the excitation library

form, then click on the "Modlify”button. The following form may appear:

Excitation data

File Infarmation

Filenarme |E:\MY STUFFYPhDMS ource CodehMySpechExample 5.1,

Title |EHampIe 5.1, page 170.exc Ll
Dezcription |Half cycle sine pulse farce

File: Farmnat & MySpec

Orniginal Properties Original Peaks

Hurnber of entries: |6 Force 10 N

Time Step [zec] 0.1
Duration [zec) 0.6
Force data in:

Modified Properties Modified Peak s

Amplification ,17 Force ’107 M
TimeScale ’17

Nurnber of entries: ,57

Time Step [zec] ’017

Diuration [gec) ’%7

Cancel

You can now modify the various factors available. Refer to 4.3.1 Add new

excitation for further information.

4.3.4 Select active excitation

In order to display the results of the calculations, you must first select the active
(selected) excitation. You can accomplish this by clicking on "Select Excitation” under

the "Excitation”menu of the main form. The following form will appear:

Select excitation

Selected excitation:

Example 5.1, page 170.exc ﬂ

Cancel |

You can select the active excitation from the dropdown list. The list is loaded with

all excitations defined in the excitation library:

27



Excitation library

Famp force, rizing time = 1zec.exc

aodify
Select
Delate

Selected Excitation:

Example 5.1, page 170.exc
Cloze

Alternatively, you can select the excitation from the above list and hit the "Select”

button on the right. The active (selected) excitation is displayed at the bottom.

4.4 Excitation calculations

All excitation data is stored in double precision arithmetic.

4.5 Results

In order to display the excitation data, you must first select the active excitation.

(Refer to 4.3.4 Select active excitation for further information)

Having selected the active excitation, you can display the data both for the

original excitation and its modified form.

The units in which the results are displayed can be changed by selecting "Units”

under the "Options”menu of the main form.

The data is displayed by selecting the appropriate graph from the “Excitations >

Plot”menu.
Below there is a sample of a simple excitation.

> Original excitation in N:
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OriginahExcitation: Example 5.1, page 170.exc
0.01 =

e, KN
I

Excitation Forc

o 0.z 04 06 o0g
Time, sec

The modified excitation results depend on various factors, such as the

amplification and timescale factors.

4.6 Printing and exporting the results

4.6.1 Print results

You can print the results of the calculations directly, by selecting "Print Analysis
Report” under the "Excitation” menu. A full report will be prepared, and a stand alone

print preview program will appear:
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N Excitation data: Example 5.1, page 170.exc

% » = Q00 >l M= 0w 3

MySpec 1.0.49 by Anstotelic B Ch (aristotelis 1 com)

eneral Diata

Title: Example 5.1, page 170.exc

Filename: C: MY STUFF\PhD\Source CodelMySpec\Example 5.1, page 170.exc
riginal Force Data: N =6
siginal Force Datain : N

Modified Force Data: N =6

mplification =1

Timescale = 1

nit System

Force : KN
Time : seconds

riginal Data

riginal Force Data: I = 6
Maximum original force : 0.01 KN

Maxiniuea otiginal force ocours at 0.3 seconds
Minimum original force : 0 KN

Minimum original force occurs at 0 seconds

M Original Time Instant Original Excitation Force

0 0 0 -l

Page 1 of 3, Zoom: 150%

Most functions of this program are self-explanatory.

4.6.2 Export results

You can export the results in a simple ASCII text file, and use it in a spreadsheet,
for example. In order to create this file, select "Export Results” from the “Excitation”

menu of the main form.

The results are fixed - aligned in columns with a header for each column. You
may need to modify the file, because both the original and the modified results are

included in the same file.
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FUUMBER ORIGINAL TIME INSTANT (sec

ORIGINAL FORCE (KN)
o

0, 0,005
0, 0, 00865
0, 0,01
0, 0, 00366
0 0,008
0 0
MODIFIED FORCE (KND

0

ANUMBE] MODIFIED TIME INSTANT (sec
0,008
0, 00866
0,01

0, 00366
0,005
o

omswnbo B ownswnbo
ourwnbo U auhiwniko

o
0
0,
0,
0,
0

The units can be changed by selecting "Units” under the "Options” menu of the

main form.

4.6.3 Print drawing

You can print directly the current drawing by selecting "Print Drawing” from the
"File” menu, as described in 2.3.1 Print drawing. The drawing is printed with the

default printer settings, using the maximum available area.

4.6.4 Save drawing

You can save the current drawing in *.bmp format by selecting "Save Image As

Bmp”from the "File”menu, as described in 2.3.2 Save Image as .bmp.
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5. Linear Elastic Analysis

5.1 General issues

MySpec calculates the linear elastic response of a stick model with one mass in

one or two directions. The equations of the 2DOF model are uncoupled.

Furthermore, MySpec evaluates the linear elastic response spectrum of a SDF

system.

Viscous damping may be used in all cases.

5.2 Calculations

The equation of motion for a viscously damped linear elastic SDF system is the

following:
m-ii+c-u+k-u=pt)

Where u is the relative displacement of the system, m-ii is the inertia force,
c-u is the damping force, ¢ is the viscous damping coefficient, k-u is the spring
force and p(¢) is the external dynamic force. (§1.5 Equation of motion: External force,
Chopra [1])

In case of an earthquake, the external dynamic force is p(t) =-m U, (t), where

i, (t) is the ground acceleration. The ground displacement u, (t) is a function of

time:

Ut(t)

The total (or absolute) displacement u, (t) is the sum of the ground displacement

u, (t) and the relative displacement u(¢) of the system at all times.
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The linear elastic response is calculated following the well-known Newmark's
Method. (§5.4 Newmark’s Method, Chopra [1])

In 1959, N. M. Newmark developed a family of time stepping methods, based on

the following equations:

Uiy :ui"'[(l_?’)'At]'ﬁi +(y-Ar)-ii,
o =t (A) i +[ (05 B)- () [-ii+] B-(ar)” i,

Typical selection for y is % For [ a selection in the range % <p< % is
satisfactory.
The following set of values is used for the average acceleration:.

7:12

p=)s
Another set of values is used for the /inear acceleration:
r=Y
A=Y
These set of values are directly related to the assumption of the variation of the

acceleration during the time step.

All parameters, such as g and y of Newmark’s method, can be modified by

selecting "Analysis” under the "Options” menu of the main form. The following form

will appear:
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Analysis options

Time step - use the minimum of:

Iv Ewxcitation's time step £ 4 Recommended walue: 1
v Perod/ |25 Use dhwaps - Recommended value: 25
v Absolute value: (0,02 Usze in combination with ather criteria

Additional duration

Calculate the responge for an additional duration of: [2p periads [Th)

Mewmark, parameters

Beta: |0.16685668EE606E7 Uzually between 176 and 1/4

Gamrma: o5 Recommended value: 0.5

Method:

| Linear &cceleration A

Bouc Wen parameters

Alpha: |1 Usually: 1.0
Beta: 01
Gamma: |g_g

Cancel |

Load Default Values

In the "Time step — use the minimum of” frame, the user can set restrictions on

the maximum value of the time step used in the calculations. In general, the user

should not modify these settings as this may result to diminished accuracy.

In the "Additional duration”frame, the user can select the additional duration for
which the program should calculate the response. This period of time corresponds to
free vibration after the end of the excitation. All graphs are plotted with magenta
colour for the forced motion, followed by green colour for the duration of the free
vibration.

In the “"Newmark parameters” frame, the user can select the parameters £ and

y of Newmark’s method.

In the "Bouc Wen parameters” frame, the user can select the parameters

A, B3,y of Bouc Wen model. These parameters refer to the Bouc-Wen model and are

not used at this point.

If you modify any of these settings, you must re-calculate the solutions of all

models.
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5.3 Single Unidirectional Model

5.3.1 Calculations

The response is calculated using Newmark’s method. Refer to 5.2 Calculations for

more information.

5.3.2 Input data

In order to use the Single Unidirectional Model, select "Single Unidirectional

Model > Options” from the ‘'Linear Elastic Analysis” menu. The following form will

appear:

Linear elastic analysis - Unidirectional options

SDF Properties Froperties
Mass: |1 | kg ﬂ Period Tr:
Stiffness: |5.8596044 [N/m -l S
Period Tri; |27 sec [Maodify; ©* Stffness © Mass)

Damping R atio: |57 E4

Earthquake: |E| Centro.eqgk j Liieaot
Excitation; [MoNE ~| || OmegaD:

In the "SDF Properties”frame, the following data is required:

» Mass: The mass of the SDF system. Make sure to select the correct units

from the drop-down list.

> Stiffness: The stiffness of the SDF system. Make sure to select the correct

units from the drop-down list.

» Period: The natural period T, of the system in seconds, which is

calculated as follows:

Tnzz.”.\/E
k

If the user types a desired value of period in the text box, one of the
previous text boxes (mass or stiffness) is changed accordingly, based on

the option button Modify : Mass Or Stiffness on the right.
Damping ratio: The damping ratio ¢ of the system, in percentage (%).

The damping ratio (or fraction of critical damping) is defined as follows:
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C c

{=—=

2-m-o,

cr

The critical damping coefficient is defined as follows:

c,=2-m-o,

|k
a)n mEVN
m

Where @, is the natural frequency. The critical damping coefficient is

used in viscously damped vibrations. For example, the equation governing

viscously damped free vibration of a SDF system is the following:
i+2-¢ o, i+o -u=0

Earthquake: In addition to or separately from the excitation, you can
select the desired earthquake from the drop-down list. Note that the

modified form of the earthquake is used in the calculations.

Excitation: In addition to or separately from the earthquake, you can
select the desired excitation from the drop-down list. Note that the

modified form of the excitation is used in the calculations.

In the "Properties”frame, the following results are displayed:

>

Period T.: The natural period of the system in seconds, which is

k

Period Tq: The natural period of damped vibration in seconds, which is

calculated as follows:

related to T, by the following equation:

T
T, =—~2—

d (1_4/2
C: The damping coefficient, which is related to the damping ratio ¢ by

the following equation:

c=2-m-ao,-§
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» OmegaN: The natural frequency @, of the SDF system, which is given by

the following equation:

> OmegaD: The natural frequency of damped vibration @, of the SDF
system, which is related to the undamped natural frequency @, by the

following equation:

w0, = o, \1-¢"

When you have successfully entered all data, click on the "OK” button. The

response is calculated automatically.
5.3.3 Results

In order to display the results, select the appropriate graph by clicking on "Sing/e
Unidirectional Model > Plot ...” from the 'Linear Elastic Analysis” menu of the main

form.

The units in which the results are displayed can be changed by selecting "Units”

under the "Options”menu of the main form.

Note that the forced vibration graph is represented by the magenta colour; the

free vibration graph is represented by the green colour.

The results for the example shown in 5.3.2 Input data and the El Centro

earthquake are the following:

> Excitation force:
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Excitation Force, N

Deformation Response, m

Mass = 1 kg, Stiffness = 9,87 N/m, Tn= 2 sec, Damping Ratio Zeta = 5 %
Earthquake: El Centro.eqk

3128

- 2o

Time, sec
Relative displacement:

Mass = 1 kg, Stiffness = 9,87 N/m, Tn= 2 sec, Damping Ratio Zeta = 5 %
Earthquake: El Centro.eqk

0137

-0.135

Time, sec

Total displacement (This is the sum of the relative displacement plus the

ground displacement, if any):
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Total Digplacement, m

Relative Welocity, mfsec

Mass = 1 kg, Stiffness = 9,87 N/m, Tn= 2 sec, Damping Ratio Zeta = 5 %
Earthquake: El Centro.eqk

0166

Time, sec

Relative velocity:

Mass = 1 kg, Stiffness = 9,87 N/m, Tn= 2 sec, Damping Ratio Zeta = 5 %
Earthquake: El Centro.eqk

0626

0,441

0 a0

Time, sec

Acceleration:
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Mass = 1 kg, Stiffness = 9,87 N/m, Tn= 2 sec, Damping Ratio Zeta = 5 %
Earthquake: El Centro.eqk
0.367

Acceleration, units of @

0321

04

Time, sec

» Spring force vs time: (In linear elastic analysis, this graph is the

deformation response graph multiplied by the stiffness, i.e. F, =k -u)

Mass = 1 kg, Stiffness = 9,87 N/m, Tn= 2 sec, Damping Ratio Zeta = 5 %
Earthquake: El Centro.eqk

1347

Spring Force, N
o

1331

Time, sec

> Spring force vs displacement: (In linear elastic analysis, all points of this

graph lie on the same line, because F, =k -u and there is no yielding)
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Damping Force, N

Spring Force, N

0z

0.1

-0.1

0.2

Mass = 1 kg, Stiffness = 9,87 N/m, Tn= 2 sec, Damping Ratio Zeta = 5 %
Earthquake: El Centro.eqk

1347

1331

0.2 0.1 0 01 0z

Diplacernent, m

Damping force: (This graph is the relative velocity graph multiplied by the
damping coefficient)

Mass = 1 kg, Stiffness = 9,87 N/m, Tn= 2 sec, Damping Ratio Zeta = 5 %
0.187 Earthquake: El Centro.eqk

-0.138

Time, sec

Inertia force: (This graph is the acceleration graph multiplied by the
mass)
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3507

Inertia Force, N
[
=

3.144

Mass = 1 kg, Stiffness = 9,87 N/m, Tn= 2 sec, Damping Ratio Zeta = 5 %
Earthquake: El Centro.eqgk

5.3.4 Simulation

a0

Time, sec

&0

In order to simulate the response of the SDF system and present it in animated

form, select "Single Unidirectional Model > Response simulation” from the ‘Linear

Elastic Analysis”menu of the main form. The following form will appear:

Linear Elastic Unidirectional Simulation

-0.4 0z

-0z 0
m
Time: |0 sec

Total Excitation Force: [0 N
Ground Displacement: |0 m
Relative Displacement: |0 m

Relative Yelocity: |0 m/sec

Total Displacement | Spring Force vs Time | Spiing Force vs Displacement | DampingForce | Inertia Force |
Tolal Excitation Force | Ground Displacement | Rielalive Displacement | Relative Velogly | Acceleration |
4
2
z 0
2
04 -4+ : : )
0 20 40 0
sec
Aceeleration: [0 witsolg || Simulatonspeed: T S Play
Total Displacement: [0 m 110 11 10/1
Spiing Force: [0 N
Damping Force: [0 M Simulstion progiess: _t |
% %
Inentia Forces [0 N g y

You can simulate the response by clicking on the "Play” button of the bottom

right frame. In the same frame, you can adjust the speed of the simulation by using

the slider and you can jump to a specific point of the simulation by using the horizontal

progress bar.

At each time instant all data is displayed in the bottom left frame.
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In the top left frame, you can see the main simulation panel which depicts an
ideal SDF system: a lumped mass on top of a massless supporting structure (column),
which, in turn, is fixed on the ground, which moves under an earthquake.

Finally, you can pick one of the diagrams available in the top right frame and
watch its progress.

During the simulation the form may look like this:

Linear Elastic Unidirectional Simulation

Total Displacement | Spring Force vs Time | Spiing Force vs Displacement | DampingForce | Inertia Force

Tolal Excitation Force  Ground Displacement | Relalive Displacement | Relative Velogly | Acceleration |

0.1

0.3+

-0.4 -0z 0 0z 04

20 40

Time: 10287 sec Aceelertions [0143 unisofg | | Simulationspeed: | —— Play
Total Excitation Force: [0335 N Total Displacement [0042 110 1M 101
Ground Displacement: [0151  m Spiing Force: [1082 N
Relative Displacement: 011 m Damping Force: [O018 1 Simulation progress: ¢ | ) |
Relative Velociy [0052  mesec Inettia Force: [T458 N = R 4

The units in which the results are displayed can be changed by selecting "Units”
under the "Options”menu of the main form.

5.3.5 Export results

You can export the results in a simple ASCII text file, and use it for example in a
spreadsheet application. In order to create this file, select "Single Unidirectional Model

> Export Results”from the "Linear Elastic Analysis”menu of the main form.

The results are fixed - aligned in columns with a header for each column.

5.4 Single Bidirectional Model

5.4.1 Calculations

The response is calculated using Newmark’s method. Refer to 5.2 Calculations for
more information.
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Note that the two degrees of freedom are uncoupled. Therefore, for the same

input as in the single unidirectional model, the results are the same in both directions.

5.4.2 Input data

In order to use the Single Bidirectional Model, select "Single Bidirectional Model >

Options”from the "Linear Elastic Analysis”menu. The following form will appear:

Linear elastic analysis - Bidirectional options

General Data

Mass: |'I |k9 j

# Direction

Stiffress: |9.8636044 [Mém |

Period Tr: '27 80 [Modify: * Stffness T Mass )

Damping Fatio: ’37 E4

Earthquake: |E| Centro.eqgk j

Excitation: [NONE |

' Direction

Stiffness: [394764176  [N/m |

Period Tr ’17 80 [Modify: ©* Stiffness © Mass )

Damping Ratia: '17 2

E arthquake: |EI Centro.eqk j

Excitation: [NOME |
Cancel |

In each of the X, Y directions, the following data is required:

> Mass: The mass of the system. Make sure to select the correct units from
the drop-down list box.

> Stiffness: The stiffness of the system. Make sure to select the correct
units from the drop-down list box.

> Period: The natural period T, of the system in seconds, which is

oo
k

If the user types a desired value of period in the text box, one of the

calculated as follows:

previous text boxes (mass or stiffness) is changed accordingly, based on
the option button Modify : Mass Or Stiffness on the right.

» Damping ratio: The damping ratio ¢ of the system, in percentage (%).

The damping ratio (or fraction of critical damping) is defined as follows:
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C c

f=—=

2-m-w,

cr

The critical damping coefficient is defined as follows:

c,=2-m-w,

|k
a)n mEVEN
m

Where @, is the natural frequency. The critical damping coefficient is
used in viscously damped vibrations. For example, the equation governing
viscously damped free vibration of a SDF system is the following:

i+2-¢ o, i+o u=0

> Earthquake: In addition to or separately from the excitation, you can
select the desired earthquake from the drop-down list. Note that the

modified form of the earthquake is used in the calculations.

> Excitation: In addition to or separately from the earthquake, you can
select the desired excitation from the drop-down list. Note that the

modified form of the excitation is used in the calculations.

When you have successfully entered all data, click on the "OK” button. The

response is calculated automatically.
5.4.3 Results

In order to display the results, select the appropriate graph by clicking on "Single
Bidirectional Model > Plot X (or Y) > ...”from the "Linear Elastic Analysis” menu of the

main form.

The units in which the results are displayed can be changed by selecting "Units”

under the "Options”menu of the main form.

Note that the forced vibration period is displayed by magenta colour; the free

vibration is displayed by green colour.

45



5.4.4 Simulation

In order to simulate the response of the system in animated form, select "Single
Bidirectional Model > Response simulation” from the "Linear Elastic Analysis” menu of

the main form. The following form will appear:

Linear Elastic Bidirectional Simulation

% Direction

| Inettia Force |

Totsl Displacement | Spring Force ve Time | Spring Force vs Displacement | Damping Force
Tetal Excitalion Feree | Ground Displacement | Deformation Fiesponse | Fielative Velociy | Acceleration |

4

2

= 0

-2

-4+

't Direction

Simulation speed Totsl Displacement | Spring Force ve Time | Spring Force vs Displacement | Damping Force | Inertia Foree |

1 Tetal Excitation Feree | Ground Displacement | Deformation Fiesponse | Fielative Velociy | Acceleration |

1410

pEalal

0%

1A

Simulation progress

1041

100%

4

2

= 0

For | \

| Close Simulation Form

You can simulate the response by clicking on the "Play”button of the left frame.
In the same frame, you can adjust the speed of the simulation by using the slider and

you can jump to a specific point of the simulation by using the horizontal progress bar.

In the top left frame, you can see the main simulation panel which depicts an
ideal 2DOF system: a lumped mass on top of a massless supporting structure

(column), which, in turn, is fixed on the ground which moves in case of an earthquake.

Finally, you can pick one of the diagrams available in the top (for the X direction)

and the bottom (for the Y direction) right frame and watch its progress.

During the simulation the form may look like this:
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Linear Elastic Bidirectional Simulation

Simulation speed.

1410 1A

Simulstien progress
jEal )

0%

1041

100%

Pause

% Direclion
Totsl Displacement | Spring Force ve Time | Spring Force vs Displacement | Damping Force | Inertia Foree

Tetal Excitalion Feree | Ground Displacement | Deformation Fiesponse | Fielative Velociy | Acceleration

4

2

= 0

-2

-4+

|
|

¥ Direction
Totsl Excitation Force | Ground Displacement | Deformation Response | Relative Velocity | Acceleration

Total Displacement  Spring Force vs Time I Spiing Force vs Displacement | DampingForce | Ineria Foree

10

|
|

Flay | Stop

o 20 40 &0

The units in which the results are displayed can be changed by selecting "Units”

under the "Options”menu of the main form.

5.4.5 Export results

You can export the results in a simple ASCII text file, and use it in a spreadsheet,
for example. In order to create this file, select "Single Bidirectional Model > Export

Results”from the "Linear Elastic Analysis”menu of the main form.

The results are fixed - aligned in columns with a header for each column.

5.5 Elastic Response Spectrum

5.5.1 Calculations

Given a range of periods for a SDF system and the time step, MySpec can
produce the elastic response spectrum of various response parameters for a specific
excitation and / or earthquake. The response is calculated using Newmark’s method for

each period (refer to 5.2 Calculations for more information).

The mass of the SDF system is needed in case of force excitations. Also, viscous

damping may be taken into account.
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The program may trim the very small periods or use a minimum time step
because the iterative process is time consuming; for each period the full response of

the SDF system must be calculated so that the peak values can be stored.

MySpec can produce response spectra for the following quantities (Refer to §6.5

Response spectrum concept, Chopra [1]):
> Deformation: The peak value of deformation D for each period.

> Pseudo velocity: The peak value of the pseudo velocity V which is

defined as follows:

V=ow-D

n

Where o, is the natural frequency and D is the peak deformation of the
same system.
Pseudo velocity has units of velocity and it is related to the peak value of

the strain energy E, stored in the system during the excitation:

2
E.r() = mV_

(86.6.2 Pseudo velocity Response Spectrum, Chopra [1])

> Pseudo acceleration: The peak value of the pseudo acceleration A which

is defined as follows:
a=w’-D
Where o, is the natural frequency and D is the peak deformation of the

same system.

Pseudo acceleration has units of acceleration and it is related to the peak

value of base shear V,, or the peak value of the equivalent static force
j:s() :

|4

D'

0 :fso:m'A

(86.6.3 Pseudo acceleration Response Spectrum, Chopra [1]),
> Relative Velocity: The peak value of the relative velocity.

» Acceleration: The peak value of the acceleration.
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5.5.2 Input data

In order to produce the elastic response spectrum, select "Response Spectrum >

Options”from the "Linear Elastic Analysis”menu. The following form will appear:

Linear Spectral Analysis - Options

Froperties
Minimum period: ’07 B0
M avirium periad: ’37 180
Period time step: ’0057 FEC
D armping: ’27 iz
Mass: |D |kg ﬂ

E arthquake: | El Centro.egk. j
Excitation. |NONE =l

The following data is required:
> Minimum period: The minimum period of the range, in seconds.
» Maximum period: The maximum period of the range, in seconds.
> Period time step: The time step, in seconds.
» Damping: The damping ratio { of the system, in percentage (%). The
damping ratio (or fraction of critical damping) is defined as follows:

(==

¢, 2-m-ao,

The critical damping coefficient is defined as follows:

c,=2-m-w,

k
o, =.,|—
m

Where , is the natural frequency.

> Mass: The mass of the SDF system. This is required in case of force

excitations. Make sure to select the correct units from the drop-down list.

> Earthquake: In addition to or separately from the excitation, you can
select the desired earthquake from the drop-down list. Note that the

modified form of the earthquake is used in the calculations.
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> Excitation: In addition to or separately from the earthquake, you can
select the desired excitation from the drop-down list. Note that the

modified form of the excitation is used in the calculations.

5.5.3 Results

In order to display the results, select the appropriate graph by clicking on
"Response Spectrum > Plot ...” from the '"Linear Elastic Analysis” menu of the main

form.

The units in which the results are displayed can be changed by selecting "Units”

under the "Options”menu of the main form.

The results for the example shown in 5.5.2 Input data and the El Centro

earthquake are the following:

> Deformation response spectrum:

Elastic Deformation Response Spectrum, Damping Ratio Zeta = 2 %
Earthquake: El Centro.eqk

@

@
\\\\l\\\\|\\\\|\\\\|\\\\|

Deformation, m

a

a
[

> Pseudo velocity response spectrum:
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Pseudo Velocity, m/sec

Pseudo Acceleration, units of g

Elastic Pseudo Velocity Response Spectrum, Damping Ratio Zeta = 2 %
Earthquake: El Centro.eqk

Period, sec

Pseudo acceleration response spectrum:

Elastic Pseudo Acceleration Response Spectrum, Damping Ratio Zeta = 2 %
Earthquake: El Centro.eqk

Period, sec

Relative velocity response spectrum:
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Relative Velocity, m/eec

Acceleration, units of g

Elastic Relative Velocity Response Spectrum, Damping Ratio Zeta = 2 %
Earthquake: El Centro.eqk

Period, sec

Acceleration response spectrum:

Elastic Acceleration Response Spectrum, Damping Ratio Zeta = 2 %
Earthquake: El Centro.eqk

Period, sec
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6. Non Linear Analysis — Bilinear Model

6.1 General issues

MySpec evaluates the non linear response based either on a generic bilinear
model or a Bouc — Wen hysteretic model.

6.2 Analysis options

All analysis parameters can be inserted or modified by selecting "Analysis” under
the "Options”menu of the main form. The following form will appear:

Analysis options

Time step - uze the minimum of;

Iv Ewxcitation's time step £ |1 Recommended walue: 1
v Period / |25 Usze Always - Recommended valus: 25
v Absolute value: |00z Use in combination with other criteria

Additiohal duration

Calculate the response for an additional duration of. |20 periods [Th)

Mewrnark parameters

Beta: | 0. 1EERERREEERREET Uzually between 1/6 and 144
Gamma: |05 Recommended value: 0.5
Method: | Linear Acceleration j

Bouc 'Wen parameters

Alpha: |-| Usually: 1.0
Beta: |D.1
Gammna: ]

Load Default Values

In the "7ime step — use the minimum of”frame, the user can set restrictions on

Cancel |

the maximum value of the time step used in the calculations. In general, the user

should not modify these settings as this may result to diminished accuracy.

In the "Additional duration”frame, the user can select the additional duration for
which the program should calculate the response. This period of time corresponds to
free vibration after the end of the excitation. All graphs display the response during
this period of time with green colour, while for the duration of the forced vibration the

response is displayed with magenta.
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In the “"Newmark parameters” frame, the user can select the parameters £ and

y of Newmark’s method.

In the “Bouc Wen parameters” frame, the user can select the parameters

A, S,y of Bouc Wen model.

If you modify any of these settings, you must re-calculate the solutions of all

models.

6.3 Calculations

MySpec evaluates the nonlinear response based on a generic bilinear model. A

typical bilinear force - displacement model is shown below:

fo A

fy

c Y

The system is linearly elastic with stiffness k& up to the yield force. For
displacement bigger than «, the system responds with a constant hardening stiffness
k, .

In the unloading branch, the system regains its initial stiffness & .

The yield strength f, and the hardening stiffness k, may be different for the

positive and negative directions of loading. Also, if the system has yielded and is

unloaded, the new elastic branch has the same yield strength range as the initial
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valuesie. f, . +

f)xneg

because of the hardening stiffness.

but may be displaced in the positive or the negative direction

The response is calculated with the well-known Newmark Method. (§5.7 Analysis

of Nonlinear response: Newmark'’s Method, Chopra [1]).

In general, Newmark’s method is very satisfactory in terms of accuracy. Since the

time step is constant, two are the main sources of error:

» The tangent stiffness is used instead of the (actual) secant stiffness in the
calculation of the incremental resisting force. The secant stiffness cannot

be used because it is not known.

> The detection of the transitions in the force — deformation relationship is

inaccurate. This inevitably leads to error accumulation.

MySpec addresses these errors by using a small time step (this can be modified
by the user) and by modifying the time step at the transitions from the elastic to

inelastic branch and vice versa.

In the first case i.e. the transition from the elastic to the inelastic branch, the
condition is that the resisting force equals the yield strength: f, = f .

In the second case i.e. the transition from the loading to the unloading branch,

the condition is that the velocity is zero: 1 =0.

When a transition is detected, the time step is continuously divided by two in
order to detect the transition point as accurately as possible. When the corresponding

condition is met to certain accuracy, the algorithm continues to the next time step.

As mentioned earlier, N. M. Newmark’s method is based on the following

equations:

tiy, =1, +[ (1= y)- At ] id, + (- At)-ii,,,
o =1t + (A1) 1+ (05 B)-(Ar)” |-ii+| B-(ar)” iy,

Typical selection for y is % For g a selection in the range % <p< % is
satisfactory.

The following set of values is used for the average acceleration:
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}/:1

2
-1
A=Y,
Another set of values is used for the /inear acceleration:
-1
=)

:B:l6

These set of values are directly related to the assumption of the variation of the

acceleration during the time step.

6.4 Input data

In order to use the bilinear model, select "Single Unidirectional (Bilinear Model) >

Options”from the "Non Linear Analysis”menu. The following form will appear:

Non linear analysis - Unidirectional options

In the

SOF Properties

M ass:
Stiffness:
Period Tr:

Positive rield:

Megative Yield:

D amping R atio:

Earthquake:

Excitation:

Positive Hardening Stiffness;

Megative Hardening Stiffness:

[10 [ka ~|

3863604401 [Nom |

|27 360 [Maodify: ©* Stiffness T Mass)
[5 [N =l

[2 [Mem |

15 N =l

[10 [N/m |

2 =

|E| Centro.egk j
[MONE =l

Cancel |

"SDF Properties”frame, the following data is required:

Mass: The mass of the SDF system. Make sure to select the correct units

from the drop-down list box.

Stiffness: The stiffness of the SDF system. Make sure to select the correct

units from the drop-down list box.

Period: The natural period T, of the system in seconds, which is

calculated as follows:



If the user types a desired value of period in the text box, one of the
previous text boxes (mass or stiffness) is changed accordingly, based on
the option button Modify : Mass Or Stiffness on the right.

> Positive yield: The positive yield strength of the system. Make sure to

select the correct units from the drop-down list box.

> Positive hardening stiffness: The positive hardening stiffness of the

system. Make sure to select the correct units from the drop-down list box.

> Negative yield: The negative yield strength of the system (use positive

values). Make sure to select the correct units from the drop-down list box.

> Negative hardening stiffness: The negative hardening stiffness of the
system (use positive values). Make sure to select the correct units from

the drop-down list box.
> Damping ratio: The damping ratio ¢ of the system, in percentage (%).

The damping ratio (or fraction of critical damping) is defined as follows:

(==

c, 2m-o,

The critical damping coefficient is defined as follows:

Ccr :2.m'a)n

k
o, =.,|—
m

Where @, is the natural frequency.

> Earthquake: In addition to or separately from the excitation, you can
select the desired earthquake from the drop-down list box. Note that the

modified form of the earthquake is used in the calculations.

> Excitation: In addition to or separately from the earthquake, you can
select the desired excitation from the drop-down list box. Note that the

modified form of the excitation is used in the calculations.

When you have successfully entered all data, click on the "OK” button. The

response is calculated automatically.
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6.5 Results

In order to display the results, select the appropriate graph by clicking on "Single
Unidirectional (Bilinear Model) > Plot ...” from the "Non Linear Analysis” menu of the

main form.

The units in which the results are displayed can be changed by selecting "Units”

under the "Options”menu of the main form.

Note that the forced vibration period is represented by magenta colour; the free

vibration is represented by green colour.

The results for the example shown in 6.3.2 Input data and the El Centro
earthquake are the following:

> Excitation force:

Mass = 10 kg, Stiffness = 98,696 N/m, Tn= 2 sec, Damping Ratio Zeta = 2 %
Earthquake: El Centro.eqk

B

Excitation Force, N
| | - | | - | | | | - | - |

&0

Time, sec

> Relative Displacement:
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Deformation Response, m

Total Displacerment, m

Mass = 10 kg, Stiffness = 98,696 N/m, Tn= 2 sec, Damping Ratio Zeta = 2 %
Earthquake: El Centro.eqk

0141

0118

Time, sec
Total displacement:
Mass = 10 kg, Stiffness = 98,696 N/m, Tn= 2 sec, Damping Ratio Zeta = 2 %
Earthquake: El Centro.eqk

013

-0.227

Time, sec

Relative velocity:
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Relative Velocity, m/sec

Acceleration, units of g

Mass = 10 kg, Stiffness = 98,696 N/m, Tn= 2 sec, Damping Ratio Zeta = 2 %

0.408

-0.3%3

Earthquake: El Centro.eqk

Acceleration:

Mass = 10 kg, Stiffness = 98,696 N/m, Tn= 2 sec, Damping Ratio Zeta = 2 %

0351

-0.302

Time, sec

Earthquake: El Centro.eqk

Spring force vs time:

Time, sec
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Spring Force, N

Spring Force, N

Mass = 10 kg, Stiffness = 98,696 Nfm, Tn= 2 sec, Damping Ratio Zeta = 2 %
Earthquake: El Centro.eqk

5078

-6.32

Time, sec

Spring force vs displacement:

Mass = 10 kg, Stiffness = 98,696 N/m, Tn= 2 sec, Damping Ratio Zeta = 2 %, Ductility Demand = 2,777
Earthquake: El Centro.eqk

5078

02 0.1 0 01 02

Diplacement, m

Damping force:
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Darmping Force, N

Inertia Force, N

Mass = 10 kg, Stiffness = 98,696 N/m, Tn= 2 sec, Damping Ratio Zeta = 2 %
Earthquake: El Centro.eqk

0511

05 000

Time, sec
Damping force:

Mass = 10 kg, Stiffness = 98,696 N/m, Tn= 2 sec, Damping Ratio Zeta = 2 %
Earthquake: El Centro.eqk

| 34420

- 20,608

Time, sec

Yielding (1 for positive yielding, 0 for the elastic branch, -1 for negative
yielding):
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Mass = 10 kg, Stiffness = 98,696 N/m, Tn= 2 sec, Damping Ratio Zeta = 2 %
Earthquake: El Centro.eqk

Yielding
5
1
f
q
I

Time, sec

6.6 Simulation

In order to simulate the response of the system in animated form, select "Single

Unidirectional (Bilinear Model) > Response simulation” from the "Non Linear Analysis

menu of the main form. The following form will appear:

Non Linear Unidirectional Simulation

Total Displacement | Spring Force vs Tme | Spring Force vs Displacement | Damping Force | Inertia Force | Yielding |
Total Excitation Force | Ground Displacement | Deformation Resporss | RelativeYelocity | Acceleration |
40
20
z 0
-20
04 02 0 0.2 0.4 -0 T !
= i 20 40 60
sec
Time: [0 380 Acceleration: [0 units of g Simulation spesd: ); Play
Total Excitation Force: [0 N Total Displacement: [0 m 110 11 1041
Ground Displacement: [I m Spiing Farce: [0 N
Deformation Fespanse: [0 n Damping Faree: [0 N Simulation progress. < | o}
Relative Velocity: [0 m/sec Inettia Force: [0 N 0% iz Q

7”7

You can simulate the response by clicking on the "Play” button of the bottom

right frame. In the same frame, you can adjust the speed of the simulation by using

the slider and you can jump to a specific point of the simulation by using the horizontal

progress bar.

At each time instant all data is displayed in the bottom left frame.
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In the top left frame, you can see the main simulation panel which depicts an
ideal SDF system: a lumped mass on top of a massless supporting structure (column),
which, in turn, is fixed on a rectangular base. This base represents the ground and it
moves in case of earthquakes.

Finally, you can pick one of the diagrams available in the top right frame and
watch its progress.

During the simulation the form may look like this:

Non Linear, Unidirectional Simulation

Total Excitation Force | Ground Displacement | Deformation Response | RelstiveVelocity | Acceleration |
Total Displacement | Spring Force vs Time  Spiing Force vs Displacement I Damping Force | Inettia Foree | Yielding |

10

5
04 02 i 0.z 04 10 T T J
e 0.2 01 0 01 0.2
m
Time: [26204  sec beceleration: [LOBT  units of g Simuatonspeed: L b Play
Tatal Excitation Force: [BB16 N Total Displacement: 0003 1410 1M 1041
Ground Displacement: [0085  m Spiing Force: [DB3E N
Deformation Aesponse: 0058 m Damping Force: [008 N Simulstion progrsss: | i o
% %
Relative Velociy: [1083  msec Inetia Force: [E3% N g e

Cloze

The units in which the results are displayed can be changed by selecting "Units”
under the "Options”menu of the main form.

6.7 Export results

You can export the results in a simple ASCII text file, and use it in a spreadsheet,
for example. In order to create this file, select "Single Unidirectional Model > Export

Results”from the "Non Linear Analysis” menu of the main form.

The results are fixed - aligned in columns with a header for each column.
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7. Non Linear Analysis — Bouc Wen Model

7.1 General issues

MySpec evaluates the nonlinear response based on a generic Bouc Wen Model.

This hysteresis or memory — dependent model is very popular because of its
versality and simplicity; it is a very concise model governed by a single differential
equation. This was first introduced by Bouc in 1967 [2]. In 1976, Wen [3], extended

the model and demonstrated its versality by producing a variety of hysteretic patterns.

7.2 Calculations

For a SDF system the restoring force can be written as:
F,
F(t)=a-—-u(r)+(1-a)-F,-z(1) (7.2.1)

where, F, is the yield force, u, is the yield displacement, « is the ratio of post-

yield to pre-yield (elastic) stiffness and z(t) is a dimensionless hysteretic parameter
obeying a single differential equation:

1

Z'(t)zu—‘[A—|z(t)

' ‘(V‘Sign(”(f)'Z(f))+ﬁ)]b't(t) (7.2.2)

where, A, S,y,n are dimensionless quantities controlling the shape of the

hysteresis loop.
The equation of motion for a SDF system with external viscous damping c is
given as:

m-ii(t)+c-u(t)+F(1)=f (1) (7.2.3)

where, u(r) is the displacement, F () is the restoring force, f(¢)is the
excitation force. Substituting (7.2.1) into (7.2.3) we obtain:
F,
m-ii(t)+c-i(t)+a-—-u(t)+(1-a)-F,-z(1)= f (1) (7.2.4)

l/t‘v

Equations (7.2.2) and (7.2.4) are transformed into a state-space form as follows:

65



x, (1) =u(r) (7.2.5)

% (1)) = —%-{c-xz(t)+a-i-xl(t)+(1—a)-Fy-)g(t)—f(t)} (7.2.6)

u y

L (A0 (- sgn(3(0) 3 1)+ £)) 1)

l/ty

The above system of three first order non-linear ODEs is solved numerically
following Livermore stiff ODE integrator which is based on a “predictor-corrector”

method [4].

Extending the above equations for a two degree of freedom system, the

equations of motion in two directions x and y are two ODEs of second order in time.

: SO S

a - 0
“o {” (I)}Jr (7.2.7)
u

Ve

These equations are coupled through the dimensionless hysteretic variables

Z, (t), z, (t) which are governed by a system of non-linear equations:

it o
[ z, .(7/.sign(blx(t).zx(t))+ﬂ) z.z, (7/ szgn( 1)z, (t))+ﬂ)}{ (,)}
202, (7-sign(i 1)z, (0))+B) 2,7 (v-sign(i, ()2, (1))+ B)

(7.2.8)

These equations were developed by Park et al. [5]. For the above system of

equations, n=2.

66



Equations (7.2.7) and (7.2.8) are converted in state space form by introducing

additional equations as follows:

=

=
N

=

Ka

—%'{cx x,(t)+a,- 5
ol | L]
xg(t) B Uyx x3(t)'x6
()|
:E’i —% {c), xs(t)+a 5)‘:

(7.2.

= x (1)+(1-a,)-

(1)=x7(1)- (7/ szgn(xz( )%, t))
(t)-(y-sign(xs()

x5 ()

> ~x4(t)+(1—ay)'

[ (1)=x; (1) x, (1) (7/ szgn(xZ( ) x
: xéz(t)‘(y/‘szgn(x5 (1)

10)

(1) +B)-x,

5 (1)) + B)-x (1)

(7.2.9)

F

v

F

¥,y

(1) +8)-x(1) }

The above system of six first order non-linear ODEs is solved numerically

following Livermore stiff ODE integrator which is based on a “predictor-corrector”

method [4].

7.3 Applications

This model is extremely useful for the investigation of the dynamic behaviour of
hysteretic Lead Rubber Bearing (LRB) and Friction Pendulum Systems (FPS); it

provides a unified base for the analyses of both types of isolators (Koumousis V. K.

[6]).

For a Lead Rubber Bearing (LRB) isolator, the restoring force is given by equation

(7.2.1). The behaviour of the mass isolator in two directions is given by equation

(7.2.7), (7.2.8).
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On the other hand, a Coulomb friction sliding system requires multiple stick — slip
conditions that result into a complicated system of equations. However, a modified
viscoplasticity model leads to a convenient formulation that describes accurately the
behaviour of a sliding system, especially for Teflon — steel interfaces, where the

coefficient of friction increases with velocity.

In this case, the friction force is determined as:

F(t)=p,-m-g-z(t) (7.3.1)

with:
1, = Fru = AF -exp(—a-[i (1)) (7.3.2)
where, f, s the coefficient at a large velocity of sliding, Af is the difference

between the coefficient of friction at a large and a very low velocity of sliding and « is

a constant. Parameters f_  and Af are generally dependent on bearing pressure,

max

whereas a is nearly independent of pressure.

The dimensionless quantity z(t) follows again equation (7.2.2) and controls the
stick — slip conditions. For slip conditions, Z(t):izmax’ while for stick conditions

(elastic behaviour) |z(t)|<z Z is dependent on the Bouc Wen parameters

max " max

A, B,y and should be equal to £1, as described in the next section.

Considering sliding on a spherical surface alters the above behaviour by adding

the pendulum effect in the second equation of state space ODE system. For small

values of u(t)/R the restoring force of the pendulum effect may be expressed by the

term, - 8-(1).

~u(t)

mguyR \
W
mg
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7.4 Behaviour of the hysteretic parameter Z for a SDF system

For an SDF system, the restoring force is given by equation (7.2.1), while the
hysteretic parameter z(r) obeys equation (7.2.2). The hysteretic parameter z(t)
takes its maximum and minimum value when the system vyields in the positive and

negative direction respectively. In order to find the extreme values of Z(t) , we set:

z(r)=0 (7.4.1)
From equation (7.4.2), we get:
i(r)=0
or (7.4.2)
A—|Z(t)n -(y-sign(d(t)-z(t))+ﬁ)=0

In the general case, the second equation yields:

A
Zoax =

o = 7.Sign(a(r)'z(t))+ﬂJ

However, when the system yields and z(¢) is either maximum or minimum, both

(7.4.3)

the velocity «(¢) and the hysteretic parameter z(r) share the same sign; for example,

while yielding in the positive direction, both «(¢) and z(z) are positive. When the

velocity diminishes and reaches zero, this is the condition that signifies the reversal of

the movement towards the negative direction and the end of yielding. Similarly, while

yielding in the negative direction, both 1 (7) z(¢) are negative. In all cases:

sign(ii(t)-z(r)) =1 (7.4.4)

Equation (7.4.5) then becomes:

1
T =( 4 j (7.4.5)
B+y
Note that 7 should be positive. For an SDF system, the parameters A, S,y
+r

should be chosen in such a way that z ==+1. This becomes apparent in an

max, min
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elastoplastic system, where the ratio a of post-yield to pre-yield (elastic) stiffness is

zero. Equation (7.2.1) then becomes:
F(t)=F,-z(r) (7.4.6)

It is obvious that, while yielding, the restoring force F should be equal to the

yield force F,, therefore, z =+1. In particular, A=1,4=0.1,y =09 are

suggested by Constantinou et al [7]. The model exhibits greater sensitivity to the

relative value of £ with respect to y and vice versa; the shape of the hysteresis loop

can be modified by these two parameters.

7.5 Behaviour of the hysteretic parameter Z for a 2DOF system

For a two degree of freedom system, the equations of motion in two directions x

and y are given by (7.2.7). The behaviour of the hysteretic parameters is controlled

by equations (7.2.8).

Constantinou et al. [7] have shown that when the system yields, equations

(7.2.8) have the following solution (provided that ﬁA =1):

z (t)=cos(0
(1) _ () 7.5.1)
z, (1) =sin(0)
where 4 is the angle of the direction of motion at each time instance:
u,
6 = ArcTan (—‘J (7.5.2)
MX

We can investigate the special case of a fully symmetrical 2DOF system i.e. a
2DOF system with the same properties in both directions, subjected to the same

excitation in both directions. Because of the symmetrical equations (7.2.7), (7.2.8), we

expect the same results for both directions. In this case, z,(z) and z,(r) should have

the same values at all times; therefore they should obtain their (common) maximum or

minimum values simultaneously. Similarly to the SDF system, the hysteretic parameter

z(t) takes its extremes values when the system yields, in either direction. In order to

find the extreme values of z, (r), we set:

70



z.(1)=0 (7.5.3)

From equation (7.2.8), we get:

i (1)=0
or

A-z, 2 -(7/-sign(ux (1)-z, (t))+ﬁ)— Zymax " Zy -(7/-sign(1;V (1)-z, (t))+ﬁ) =0
(7.5.4)

The general case is given by the second equation. When the system yields and

z,(t) is either maximum or minimum, both the velocity u,(7) and the hysteretic
parameter z, (t) share the same sign; for example, while yielding in the positive

direction of x axis, both the velocity i, (7) and the hysteretic parameter z, (r) are

positive. When the velocity diminishes and reaches zero, this is the condition that

signifies the reversal of the movement towards the negative direction and the end of

yielding. Similarly, while yielding in the negative direction of x axis, both u_ (t) and

z,(¢) are negative. In all cases:

sign(u, (1)-z,(1)) =1 (7.5.5)

Because of the symmetry, the same equation is valid for direction y:

sign(ii, (1)-z, (1)) =1 (7.5.6)
Equation (7.5.4) becomes:
A= 2 (BH7) = Zeman Ly (B+7) =0 (7.5.7)
We expect:
Zemax = Zymax (7.5.8)

Combining equations (7.5.6) and (7.5.7) we obtain:

Py . S (7.5.9)

max 2'(ﬁ+}/)
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Equations (7.5.1) provide the same result as equation (7.5.9), since the angle of

the direction of motion is 45° (due to symmetry) and cos(45° ) = sin(45°) _ L

5

7.6 Input data

In order to use the Bouc Wen model, select "Bouc Wen Analysis > Options”. The
following form will appear:

Non linear analysis - Bouc Wen model - Options.

General Options
Mas: I
* Direction
F 286 N -
Uy 011 m -
a 01
0 Nsec/m  x
Earthquake: [wonE ~|
Excitation [wonE ~|
Initis] Displacement: 1 m -
Initial Velocity 1 m/sec -
¥ Direction
Fi 286 N -
Uy 011 m -
a 01
0 Nsec/m v
Earthquake: [wonE |
Excitation [wonE |
el Displacemer:. 1m0 ]
Initial Velocity 2 m/sec -

In the "General Data”frame, the following data is required:

» Mass: The mass of the system. Make sure to select the correct units from
the drop-down list box.

Both in the "X direction” and the "Y direction” frame, the following data is

required:

> F,: The yield force of the system. Make sure to select the correct units
from the drop-down list box.

» U,: The yield displacement of the system. Make sure to select the correct

units from the drop-down list box.
> a: The ratio of post-yield to pre-yield (elastic) stiffness. Dimensionless.

> ¢: The viscous damping. Make sure to select the correct units from the
drop-down list box.
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> Earthquake: In addition to or separately from the excitation, you can
select the desired earthquake from the drop-down list box. Note that the

modified form of the earthquake is used in the calculations.

> Excitation: In addition to or separately from the earthquake, you can
select the desired excitation from the drop-down list box. Note that the

modified form of the excitation is used in the calculations.

> Initial displacement: The initial displacement of the system. . Make sure to

select the correct units from the drop-down list box.

> Initial velocity: The initial velocity of the system. Make sure to select the

correct units from the drop-down list box.

Note that the usage of an earthquake or an excitation is not compulsory; you can
use an initial displacement or velocity instead.

Also note that the rest of Bouc-Wen’s parameters i.e. A, f,y can be modified by

selecting "Analysis”under the "Options” menu of the main form. Refer to 6.2 Analysis
Options for more information. Because of the equations (7.2.10) which are used for

the calculations, parameter n is fixed (n=2).

When you have successfully entered all data, click on the "OK” button. The

response is calculated automatically.

7.7 Results

In order to display the results, select the appropriate graph by clicking on "Bouc
Wen Analysis > Plot X (or Y) > ...”menu of the main form.

The units in which the results are displayed can be changed by selecting "Units”

under the "Options”menu of the main form.

Note that the forced vibration period is displayed by magenta colour; the free

vibration is displayed by green colour.

7.8 Simulation

In order to simulate the response of the system in animated form, select "Bouc

Wen Analysis > Response simulation”. The following form will appear:
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Non Linear Bouc Wen Bidirectional Simulation

# Direction
FRielative Velocity ] Acceleration Taotal Displacement ] Spiing Force vz Time ]
7 Spring Force vz Displacement ] Damping Farce ] Inertia Force ] Z Parameter ]
Total Excitation Force Ground Displacement ] Relative Displacement ]
4
2
= 0
-2
B T 1
0 pein 100
' Direction
Simulation speed: Relative Welocity ] Acceleration Total Displacement ] Spring Force ve Time ]
)' Spring Force ve Displacement ] Dramping Force ] Ineitia Force ] Z Parameter ]
"""""""""" Tatal Excitation Force Ground Displacement ] Relative Displacement ]
110 14 1041
1
Simulation progress:
E) ]
0% 100% = 0
Play | |
il T 1
a 51"1& 100
‘ Cloze Simulation Fomn |

You can simulate the response by clicking on the "Play”button of the left frame.
In the same frame, you can adjust the speed of the simulation by using the slider and

you can jump to a specific point of the simulation by using the horizontal progress bar.

In the top left frame, you can see the main simulation panel which depicts an
ideal 2DOF system: a lumped mass on top of a massless supporting structure

(column), which, in turn, is fixed on the ground which moves in case of an earthquake.

Finally, you can pick one of the diagrams available in the top (for the X direction)
and the bottom (for the Y direction) right frame and watch its progress.

During the simulation the form may look like this:
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Non Linear Bouc Wen Bidirectional Simulation

% Direction

Relative Velacity | Acesleration | Total Displacement | Spiing Force ws Time
Total Excitation Force | Ground Displacement | Diformation Fiespanse
Spring Farce vs Displacement ] Damping Force | Inertia Force: | Z Parameter

20

2 o . 2 4
¥ Direction
Simulation speed Relative Velacity | Acesleration Total Displscament | Spiing Force ws Tims |
} Spiing Force vs Displacement | Damping Force InetiaFoce | ZPammeter |
b 6% bilo G0 00 610 0 o o Total Excitation Force | Ground Displacement Deformalion Fiesponse
1710 11 1071
15
Simulation progress
i} Lol
LT 1) | /
0% 100% E
21
For | \
2+ . T .
o 10 20 30

| Close Simulation Form |

The units in which the results are displayed can be changed by selecting "Units”
under the "Options”menu of the main form.
7.9 Export results

You can export the results in a simple ASCII text file, and use it in a spreadsheet,

for example. In order to create this file, select "Bouc Wen Analysis > Export Results’.

The results are fixed - aligned in columns with a header for each column.

7.10 Validation

In order to validate the performance of MySpec in estimating the response of a
hysteretic system under known excitation, the following problem is considered:

7.10.1 Problem formulation

Assume that we have a SDF hysteretic oscillator that obeys the Bouc - Wen

model excited by a sinusoidal excitation of the form:
f(t)=sin((0.03-1+0.2)-1) (7.10.1)

We select this kind of excitation because its Power Spectral Density (PSD)
resembles to the one caused by an earthquake. The properties of the oscillator are
summarized in the following table:
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m= 1
c= 0.632455532

o= 3.162278
(= 10%
uy= 0.1

Fy™ 1

Based on other researcher’s work (Constantinou et al. [7]), the values of the

Bouc Wen parameters are set as follows:

A= 1
B= 0.1
y= 0.9
n= 2

Tsai et al. [8], showed that the latter problem can be solved in an incremental
form analytically. Therefore, solving this problem with MySpec and comparing the
results with these from the analytical model we are able to validate the results. The
method used for analytical modeling of the Bouc - Wen model is shown in the next

paragraph.
7.10.2 Analytical Solution of the Bouc - Wen model

If we consider a small displacement increment du , the Bouc - Wen model can be

described as follows:

dz() _ du@) o du(D) du(t)
" u, =A " Izl [7/ Slgn( 7 Z(t)j—i—ﬁ'j 2 (7.10.2)

du (t)

By virtue of the same sign between g and du(t) the latter equation can be
t

rewritten as:

dz(t)-u, =A-du(r)-IlzI" (}/'sign(du(t)-z(t))+ﬂ)'du(t) (7.10.3)
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One can set:
y(t)=y-sign(du(t)~z(t))+ﬂ (7.10.4)
We can also express hysteretic parameter z(t) z as a function of the value of the
previous time step plus a small increment dz :
Z=2,+dz (7. 10.5)

Substitution of equations (7.10.4) and (7.10.5) into equation (7.10.3) results in

an n-degree polynomial:
|z, +dz I’ -y(t)-du(t)+dz-uY —A-du(t) =0 (7. 10.6)

For our case, where n =2, one can evaluate the exact solution of dz for each

time step from:

1
dzz_z y(1)-du(t
(s +2 20 3(0)- (1) £y + 4y 2y (1)-da () + - ()5 (1) A )

(7.10.7)

Combining the above equation with the method of linear acceleration, one is able

the compute response of a hysteretic oscillator analytically in an incremental form.
7.10.3 Comparison and results

The assumed problem was solved with the proposed analytical method as well as
with MySpec. As can be shown from the following figure, the two methods provide
almost identical results. The mean squared errors for each parameter are summarized
in the following table table 2.

Parameter Displacement Velocity Acceleration VA

Mean squared

2107 10 3-10* 3-10*
error

From the above table it becomes obvious that the mean global error of the
numerical used by MySpec is of the order 10™*.
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Displacament [m]

Velocity [m/sec]

Acceleration [m/sec*2]

[l
T
1

L}

-0,1 4

-0,2 4

-03 -

0.6 q

04 A

0.2 1

Time [sec]

T
L

——analytical solution

— MySPec

0,2 1

04 4

0g -

Time [sec]

——analytical solution
— MySPec

Ty
10

MW J\A |
¥

Time [sec]
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Spring Force [N]

— analytical solution
157 .

03 0, , 03

——analytical solution
— MySPec

158

Displacement [m]

i

— MySFec

Time [sec]
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